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• 3 AC adapters — one 12 V DC, 1 A, for use with LP3500 module and Prototyping Board, two 9 V DC, 
400 mA for use with MaxStream 900 MHz XCite™ wireless data modules.

• Programming cable with 10-pin header and DB9 
connections, and level-matching adapter board.

• 2 serial cables — one DB9F to DB9M, one DB9M to 
bare wire leads.

• Four standoffs with mounting screws.

• Getting Started instructions.

9. Turn the Interface Board OFF, then use the DB9M to bare 
wire leads serial cable to connect this Interface Board to 
header J41 on the LP3500 Prototyping Board. Turn the 
Interface Board back ON.

10.Connect the other Interface Board to your PC COM port 
(see Step 3) and repeat Steps 5–8. Leave this Interface 
Board connected to your PC.

After you place the Interface Board connected to the LP3500 
some distance away from the PC workstation, you will be able to 
try to control the LP3500 wirelessly from the PC workstation.

Wireless Control Demonstration
Start the ModbusMaster application that you installed from the supplemental CD — double-click the Modbus-
Master.exe file in the Dynamic C Modbus folder. Select the LP3500 from the Board pulldown menu, then 
select your choice of any of DigOut 0 to DigOut 3. The corresponding LEDs on the LP3500 Prototyping Board 
will light up once you click “Update Digital Outputs.”

Where Do I Go From Here?
You are now ready to go on to other sample programs and to develop your own applications. Application Note 
AN414, Wireless Control Application Kit, takes you through loading and using the sample programs included 
with the supplemental CD, and references additional resources on wireless communications. The LP3500 
User's Manual provides complete hardware reference information, and describes the software function calls for 
the LP3500 and the Prototyping Board. These documents and additional information about the XCite™ wire-
less data modules and their use and specifications can be accessed via the documentation page that was installed 
from the supplemental CD on your PC desktop.

Visit www.rabbit.com/products/rohs/products.shtml for information on RoHS and PCB colors.

Troubleshooting
• Use the Dynamic C Help menu to get further assistance with Dynamic C.
• Remember to reconfigure the wireless data modules for the PPP sample programs as described in AN414.
• Check the Rabbit Semiconductor Technical Bulletin Board and forums at www.rabbit.com/support/bb/ 

and at www.rabbit.com/forums/.

• Use the Technical Support e-mail form at www.rabbit.com/support/questionSubmit.shtml.

NOTE: If you purchased your Wireless Control Application Kit through a distributor or through a 
Rabbit Semiconductor partner, contact the distributor or partner first for technical support.
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RS-232 cable
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LP3500 +
Prototyping Board

Installing Dynamic C®

Insert the Dynamic C CD from the Appli-
cation Kit in your PC’s CD-ROM drive. If 
the installation does not auto-start, run the 
setup.exe program in the root directory 

ll the software 
 and any 
les after you 
Rabbit and Dynamic C are registered trademarks of Rabbit Semiconductor Inc.

• Rabbit 3000 Processor Easy Reference poster.

• MaxStream catalog.

• Registration card.

of the Dynamic C CD. Insta
from the supplemental CD
Dynamic C software modu
install Dynamic C.
Wireless Control Application Kit
(900 MHz XCite™ RF Modules)

The Wireless Control Application Kit highlights the interface of MaxStream’s 900 MHz XCite™ wireless 
data modules with one of Rabbit Semiconductor’s single-board computers, the LP3500. The Wireless 
Control Application Kit comes with sample programs that illustrate the simple configuration and control of 
a new or existing Rabbit-based embedded system via a wireless interface using either the Modbus protocol 
or a direct point-to-point protocol (PPP) serial connection with a Web browser.

Application Kit Contents
• 5 CD-ROMs — Dynamic C® with complete product documentation on disk, Dynamic C RabbitWeb 

module, Dynamic C Point-to Point Protocol (PPP) module, Dynamic C Modbus module, and supple-
mental CD with sample programs and information related to the Wireless Control Application Kit.

• LP3500 single-board computer.

• LP3500 Prototyping Board with pushbutton switches, LEDs, and screw-terminal headers.

• 2 MaxStream 900 MHz XCite™ wireless data modules.

• 2 MaxStream RS-232/RS-485 Interface Boards for use with MaxStream XCite™ wireless data modules.

Quick Start Guide
1. Install Dynamic C and remaining Wireless Control Application Kit software.

2. Attach the LP3500 to Prototyping Board, connect programming cable to PC, connect AC adapter.

3. Set up the XCite™ wireless data module and attach it to the RS-232/RS-485 Interface Board.

4. Configure your PC and network connections for the sample programs you will be running.

5. Explore the sample programs in the Dynamic C SAMPLES\WirelessControl folder. There is 
also a ModbusMaster application to demonstrate wireless control described in these Getting Started 
instructions.

http://www.zworld.com/support/bb/index.html
http://www.rabbit.com/products/rohs/products.shtml
http://www.zworld.com/support/questionSubmit.shtml


set may be done by pressing the RESET switch on the LP3500. The LP3500 may also be reset by unplug-
er, then plugging it back in. However, when the LP3500 is operating in the power-save mode, the backup 
e sufficient voltage to prevent a reset from happening, in which case you will have to press the RESET 
500. Reset switches are located on both sides of the LP3500 board.

gram
ected as described, start Dynamic C by double-clicking on the Dynamic C icon on your desktop or 

ort to connect your computer to the LP3500, choose Options > Project Options and check “Use 
r” in “Serial Options” on the Communications tab. Click OK to save the settings.

en the MODBUS_SERIAL_SLAVE.C sample program in the Dynamic C SAMPLES\Modbus 
y F9 to compile and run the program. Remove the programming cable and reset the LP3500 once 
ed and is running. A reset switch is located on both sides of the LP3500 near the programming 

s Data Module Setup
s on both RS-232/RS-485 Interface Boards to 
[Switch 1 is ON (up) and the remaining 5 
own)].
 wireless data module to an RS-232/RS-485 

hown at right.
9M serial cable to connect one Interface Board 
rt. You may use the RS-232/USB converter 
 if your PC does not have a COM port.

lick setup_x-ctu.exe in the Dynamic C 
U software directory to install the X-CTU application that you will use to set up the wire-

dapter to the power input on the RS-232/RS-485 Interface Board. Use the ON/OFF switch on 

XCite™
RF Module

RS-232/RS-485
Interface

Board

O
N

1 2 3 4 5 6

Config
button

Ds SERIAL
CONNECTOR

POWER
INPUT
LP3500 Connections
Use the 4-40 screws to attach the metal standoffs to the LP3500 board as shown.

Remove Battery Tab
The backup battery on the LP3500 has a plastic tab to protect the battery against dis-
charging before the LP3500 is placed into service. The backup battery protects the con-
tents of the SRAM and keeps the real-time clock running when regular power to the 
LP3500 is interrupted.

Attach LP3500 to Prototyping Board
Press the pins from the headers on the bottom side of the LP3500 
firmly into the corresponding header sockets located at J1, J2, and J4 
on the Prototyping Board.

NOTE: It is important that you line up the header pins on the LP3500 
exactly with the corresponding header sockets J1, J2, and J4 on the 
Prototyping Board. The header pins may become bent or damaged 
if the pin alignment is offset, and the LP3500 will not work. Perma-
nent electrical damage may also result if a misaligned LP3500 is 
powered up.

Connect Programming Cable
The programming cable connects the LP3500 to the PC 
running Dynamic C to download programs and to moni-
tor the LP3500 during debugging.

Connect the 10-pin connector of the programming cable 
labeled PROG to header J5 on the LP3500. Ensure that 
the colored edge lines up with pin 1 as shown. (Do not use 
the DIAG connector, which is used for a normal serial 
connection.) Connect the other end of the programming 
cable to a COM port on your PC.

NOTE: Be sure to use the programming cable (Part No. 
101-0513) supplied with this Application Kit—the 
programming cable has red shrink wrap around the 
RS-232 converter section located in the middle of the 
cable. Programming cables from other Rabbit Semi-
conductor kits are not designed to work with the 
LP3500.
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Plug in the AC adapter.

NOTE: A hardware re
ging the AC adapt
battery will provid
switch on the LP3

Run a Sample Pro
Once the LP3500 is conn
in your Start menu.

If you are using a USB p
USB to Serial Converte

Use the File menu to op
folder. Press function ke
the program has compil
header.

XCite™ Wireles
1. Set the DIP switche

the RS-232 Mode 
switches are OFF (d

2. Mount each XCite™
Interface Board as s

3. Use the DB9F to DB
to your PC COM po
(Part No. 540-0070)

4. Locate and double-c
DCRabbit…\X-CT
less data modules.

5. Connect a 9 V AC a
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NOTE: Some PCs now come equipped only with a USB port. It may be possible to use an RS-232/USB converter (Part 
No. 540-0070) with the programming cable supplied with the Application Kit. Note that not all RS-232/USB convert-
ers work with Dynamic C.

Connect Power Supply
If you have the universal AC adapter, prepare the AC adapter for the country where it will be used by selecting the 
appropriate plug. Snap in the top of the plug assembly into the slot at the top of the AC adapter as shown, then press 
down on the plug until it clicks into place.

Hook up the connector from the 12 V AC adapter to header J5 on the Prototyping Board as shown above. The orien-
tation of this connector is not important since the VIN (positive) voltage is the middle pin, and GND is available on 
both ends of the three-pin header J5.

NOTE: Do not connect the AC adapter to the VBAT terminal on the Prototyping Board. The VBAT terminal supplies the 
backup battery voltage of 3 V, and the LP3500 may be damaged if subjected to the raw DC voltage from the AC 
adapter through the VBAT terminal.

the RS-232/RS-485 Interface Board to turn the Interface Board on— the red LED should light up.
6. Start X-CTU from the desktop icon and set the “PC Settings” tab to 38400 baud, NONE flow control, 8 data 

bits, parity NONE, 1 stop bit. Click Test/Query, then click OK when you get the report “Communication with 
modem…OK” that displays the modem type and firmware. Note the modem type (XC09-038). The settings in 
this step apply only when you have a module “fresh out of the box” — otherwise use the settings in Step 8.

7. Click Read on the “Modem Configuration” tab. The 
modem type identified in the previous step should display, 
and you will now set the serial options specified at right. 
Click Write when you have set the serial options.

8. Now set the “PC Settings” tab to 9600 baud, NONE flow 
control, 8 data bits, parity NONE, 1 stop bit. Click Test/
Query, then click OK when you get the report “Communi-
cation with modem…OK” that displays the modem type and firmware.

• AT Command/Serial Interface Options
CD – D03 Configuration = 2 - low

• Non-AT Settable Parameters/Serial Interfacing Options
Baud Rate = 3 - 9600
DI2 Configuration = 1 - RTS flow control



LP3500 Connections
Use the 4-40 screws to attach the metal standoffs to the LP3500 board as shown.

Remove Battery Tab
The backup battery on the LP3500 has a plastic tab to protect the battery against 
discharging before the LP3500 is placed into service. The backup battery protects the 
contents of the SRAM and keeps the real-time clock running when regular power to 
the LP3500 is interrupted.

Attach LP3500 to Prototyping Board
Press the pins from the headers on the bottom side of the LP3500 
firmly into the corresponding header sockets located at J1, J2, and 
J4 on the Prototyping Board.

NOTE: It is important that you line up the header pins on the LP3500 
exactly with the corresponding header sockets J1, J2, and J4 on the 
Prototyping Board. The header pins may become bent or damaged 
if the pin alignment is offset, and the LP3500 will not work. Perma-
nent electrical damage may also result if a misaligned LP3500 is 
powered up.

Connect Programming Cable
The programming cable connects the LP3500 to the PC 
running Dynamic C to download programs and to mon-
itor the LP3500 during debugging.

Connect the 10-pin connector of the programming cable 
labeled PROG to header J5 on the LP3500. Ensure that 
the colored edge lines up with pin 1 as shown. (Do not 
use the DIAG connector, which is used for a normal 
serial connection.) Connect the other end of the pro-
gramming cable to a COM port on your PC.

NOTE: Be sure to use the programming cable (Part No. 
101-0513) supplied with this Application Kit—the 
programming cable has red shrink wrap around the 
RS-232 converter section located in the middle of the 
cable. Programming cables from other Rabbit Semi-
conductor kits are not designed to work with the 
LP3500.

NOTE: Some PCs now come equipped only with a USB port. It may be possible to use an RS-232/USB converter (Part 
No. 540-0070) with the programming cable supplied with the Application Kit. Note that not all RS-232/USB convert-
ers work with Dynamic C.

Connect Power Supply
Hook up the connector from the 12 V AC adapter to header J5 on the Prototyping Board as shown above. The 
orientation of this connector is not important since the VIN (positive) voltage is the middle pin, and GND is 
available on both ends of the three-pin header J5.

NOTE: Do not connect the AC adapter to the VBAT terminal on the Prototyping Board. The VBAT terminal supplies the 
backup battery voltage of 3 V, and the LP3500 may be damaged if subjected to the raw DC voltage from the AC 
adapter through the VBAT terminal.

Plug in the AC adapter. If you are using your own power supply, it must provide 3 V to 30 V DC—voltages 
outside this range could damage the LP3500.
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 NOTE: A hardware reset may be done by pressing the RESET switch on the LP3500. The LP3500 may also be reset by unplug-
ging the AC adapter, then plugging it back in. However, when the LP3500 is operating in the power-save mode, the backup 
battery will provide sufficient voltage to prevent a reset from happening, in which case you will have to press the RESET 
switch on the LP3500. Reset switches are located on both sides of the LP3500 board.

un a Sample Program
nce the LP3500 is connected as described, start Dynamic C by double-clicking on the Dynamic C icon or by double-

licking on dcrab_XXXX.exe in the Dynamic C root directory, where XXXX are version-specific characters.

f you are using a USB port to connect your computer to the LP3500, choose Options > Project Options and check 
Use USB to Serial Converter” in “Serial Options” on the Communications tab. Click OK to save the settings.

se the File menu to open the MODBUS_SERIAL_SLAVE.C sample program in the Dynamic C SAMPLES\Modbus 
older. Press function key F9 to compile and run the program. Remove the programming cable and reset the LP3500 
nce the program has compiled and is running. A reset switch is located on both sides of the LP3500 near the 
rogramming header.

Cite™ Wireless Data Module Setup
. Set the DIP switches on both RS-232/RS-485 Interface Boards to 

the RS-232 Mode [Switch 1 is ON (up) and the remaining 5 
switches are OFF (down)].

. Mount each XCite™ wireless data module to an RS-232/RS-485 
Interface Board as shown at right.

. Use the DB9F to DB9M serial cable to connect one Interface Board 
to your PC COM port. You may use the RS-232/USB converter 
(Part No. 540-0070) if your PC does not have a COM port.

. Locate and double-click setup_x-ctu.exe in the Dynamic C 
DCRabbit…\X-CTU software directory to install the X-CTU application that you will use to set up the wire-
less data modules.

. Connect a 9 V AC adapter to the power input on the RS-232/RS-485 Interface Board. Use the ON/OFF switch on 

XCite™
RF Module

RS-232/RS-485
Interface

Board

O
N

1 2 3 4 5 6

Config
button

ON/OFF
SWITCH

LEDs SERIAL
CONNECTOR

POWER
INPUT
the RS-232/RS-485 Interface Board to turn the Interface Board on— the red LED should light up.
. Start X-CTU from the desktop icon and set the “PC Settings” tab to 38400 baud, NONE flow control, 8 data 

bits, parity NONE, 1 stop bit. Click Test/Query, then click OK when you get the report “Communication with 
modem…OK” that displays the modem type and firmware. Note the modem type (XC09-038). The settings in 
this step apply only when you have a module “fresh out of the box” — otherwise use the settings in Step 8.

.

.

Click Read on the “Modem Configuration” tab. The 
modem type identified in the previous step should display, 
and you will now set the serial options specified at right. 
Click Write when you have set the serial options.
Now set the “PC Settings” tab to 9600 baud, NONE flow 
control, 8 data bits, parity NONE, 1 stop bit. Click Test/
Query, then click OK when you get the report “Communi-
cation with modem…OK” that displays the modem type and firmware.

• AT Command/Serial Interface Options
CD – D03 Configuration = 2 - low

• Non-AT Settable Parameters/Serial Interfacing Options
Baud Rate = 3 - 9600
DI2 Configuration = 1 - RTS flow control



Wireless Control Application Kit
(900 MHz XCite™ RF Modules)

The Wireless Control Application Kit highlights the interface of MaxStream’s 900 MHz XCite™ wireless 
data modules with one of Rabbit Semiconductor’s single-board computers, the LP3500. The Wireless 
Control Application Kit comes with sample programs that illustrate the simple configuration and control of 
a new or existing Rabbit-based embedded system via a wireless interface using either the Modbus protocol 
or a direct point-to-point protocol (PPP) serial connection with a Web browser.

Application Kit Contents
• 5 CD-ROMs — Dynamic C® with complete product documentation on disk, Dynamic C RabbitWeb 

module, Dynamic C Point-to Point Protocol (PPP) module, Dynamic C Modbus module, and supple-
mental CD with sample programs and information related to the Wireless Control Application Kit.

• LP3500 single-board computer.

• LP3500 Prototyping Board with pushbutton switches, LEDs, and screw-terminal headers.

• 2 MaxStream 900 MHz XCite™ wireless data modules.

• 2 MaxStream RS-232/RS-485 Interface Boards for use with MaxStream XCite™ wireless data modules.

9. Turn the Interface Board OFF, then use the DB9M to bare 

-click the Modbus-
ulldown menu, then 
 Prototyping Board 

 Application Note 
 programs included 
. The LP3500 
re function calls for 

 the XCite™ wire-
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R
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VIN

GNDVIN

GND

GND

VIN

JP8
JP7

JP10
JP9

Q3Q4 D23
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R19

R21 R27
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C69
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232 cable

3500 +
ping Board

Quick Start Guide
1. Install Dynamic C and remaining Wireless Control Application Kit software.

2. Attach the LP3500 to Prototyping Board, connect programming cable to PC, connect AC adapter.

3. Set up the XCite™ wireless data module and attach it to the RS-232/RS-485 Interface Board.

4. Configure your PC and network connections for the sample programs you will be running.

5. Explore the sample programs in the Dynamic C SAMPLES\WirelessControl folder. There is 
also a ModbusMaster application to demonstrate wireless control described in these Getting Started 
instructions.
wire leads serial cable to connect this Interface Board to 
header J41 on the LP3500 Prototyping Board. Turn the 
Interface Board back ON.

10.Connect the other Interface Board to your PC COM port 
(see Step 3) and repeat Steps 5–8. Leave this Interface 
Board connected to your PC.

After you place the Interface Board connected to the LP3500 
some distance away from the PC workstation, you will be able to 
try to control the LP3500 wirelessly from the PC workstation.

Wireless Control Demonstration
Start the ModbusMaster application that you installed from the supplemental CD — double
Master.exe file in the Dynamic C Modbus folder. Select the LP3500 from the Board p
select your choice of any of DigOut 0 to DigOut 3. The corresponding LEDs on the LP3500
will light up once you click “Update Digital Outputs.”

Where Do I Go From Here?
You are now ready to go on to other sample programs and to develop your own applications.
AN414, Wireless Control Application Kit, takes you through loading and using the sample
with the supplemental CD, and references additional resources on wireless communications
User's Manual provides complete hardware reference information, and describes the softwa
the LP3500 and the Prototyping Board. These documents and additional information about
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RS-232 cable

GND      RxE      TxE      GND      RxC      TxC      GND     RxB       TxB      GND        +  485  –         

5     AIN4      AIN3     AIN2     AIN1     AIN0    GND

IN15     IN14      IN13     IN12      IN11     IN10     IN09      IN08     GND     IN07     IN06      IN05     IN04      IN03     IN02     IN01      IN00      GND

J23

J11

J12

J1

J13

J41 J42 J4

VIN GND

J3

3 V VBAT

JP1 JP2

JP3

JP4

JP5 JP6

JP11

JP12

RP1

D3

RP2

D6

D12D10

RP4

RP3 D16

D14

R14

C14

R15

C9
R5

R8

R35

C25

C31

C18

C28

C30

RP8

8–150–7IN
R10

R11
R12

R2
R3

R4

+K
GND

VCC

D9C7
C5

C1 C4

C23C17

RS-

LP
Prototy
Rabbit and Dynamic C are registered trademarks of Rabbit Semiconductor Inc.020–0129 • 070831–B

• 3 AC adapters — one 12 V DC, 1 A, for use with LP3500 module and Prototyping Board, two 9 V DC, 
400 mA for use with MaxStream 900 MHz XCite™ wireless data modules.

• Programming cable with 10-pin header and DB9 
connections, and level-matching adapter board.

• 2 serial cables — one DB9F to DB9M, one DB9M to 
bare wire leads.

• Four standoffs with mounting screws.

• Getting Started instructions.

• Rabbit 3000 Processor Easy Reference poster.

• MaxStream catalog.

• Registration card.

less data modules and their use and specifications can be accessed via the documentation page that was installed 
from the supplemental CD on your PC desktop.

Visit www.rabbit.com/products/rohs/products.shtml for information on RoHS and PCB colors.

Troubleshooting
• Use the Dynamic C Help menu to get further assistance with Dynamic C.
• Remember to reconfigure the wireless data modules for the PPP sample programs as described in AN414.
• Check the Rabbit Semiconductor Technical Bulletin Board and forums at www.rabbit.com/support/bb/ 

and at www.rabbit.com/forums/.

• Use the Technical Support e-mail form at www.rabbit.com/support/questionSubmit.shtml.

NOTE: If you purchased your Wireless Control Application Kit through a distributor or through a 
Rabbit Semiconductor partner, contact the distributor or partner first for technical support.

Installing Dynamic C®

Insert the Dynamic C CD from the Appli-
cation Kit in your PC’s CD-ROM drive. If 
the installation does not auto-start, run the 
setup.exe program in the root directory 
of the Dynamic C CD. Install the software 
from the supplemental CD and any 
Dynamic C software modules after you 
install Dynamic C.

http://www.zworld.com/support/bb/index.html
http://www.rabbit.com/products/rohs/products.shtml
http://www.zworld.com/support/questionSubmit.shtml
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